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Creating Teacher Pages with Manila
LPS Tech Lit Grant Training

Introduction

Welcome to Manila an Internet server application built atop the Frontier content management system. Manila
features browser based editing of web content greatly reducing the complexity associated with editing a web site
via an html authoring application such as Dreamweaver, FrontPage, or GoLive. Using the Manila environment
it is possible to create sites with very advanced forms of media it is best to start basic and put most of your
energy into the content. Glitz is great, but our experience suggests that it is the content that will keep people
coming back. The good news is that getting content on your site is very easy as you’ll see in the following
examples.

Login to your site

Since Manila offers browser-based editing of web sites when it is time to edit your site the only thing you will
need is a web browser (Netscape or Internet Explorer) and a network connection. That means that if you have a
modem or broadband connection at home you can update your web site from there.

1. Start Netscape or Internet Explorer.

Once your web browser is started enter the address: http://teachers.lps.org/username/admin. Remember to
place the user name supplied by the workshop leader in the address. An example of this with the user name
“klanger” is shown below.

2. Enter the email address and password provided by the workshop leader in the appropriate spaces and click
the Login button.

The Manila editing environment

Once you have logged into your web site you will
see the Manila editing options as a group of
hypertext links just beneath the title header. In
addition you will see an “Edit this Page” button at
the bottom of the page. Each of these options
allows you to edit your site in a particular fashion.
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Stories Manila refers to web pages as “stories.” Clicking on this option will show you a list of all the
web pages on your site and allow you to add additional pages. Each web site begins with just
two pages (Home and About). You add additional pages by clicking the “Create a New
Story” link.

Pictures Manila allows you to easily add pictures in the .gif or .jpg formats to your site. Clicking on
this option displays a list of all the pictures you have added to your site and allows you to add
additional pictures by clicking the “Create a New Picture” link.

Gems Manila refers to rich media forms such as Acrobat documents, Quicktime movies, Flash files
and Hyperstudio stacks as “gems.” Clicking on this option will display all gems you have
added to your site and allow you to add gems by clicking on the “Create a New Gem” link.

Shortcuts Manila helps you keep track of all the gems, pictures and pages on your site. It does this by
creating a named reference to each of these objects each time you add one. The value of
shortcuts is that you can add an item (or link to an item) by simply enclosing the shortcut
name inside quotations when editing a page.

Discuss When you click on this option Manila will display all “news” stories on your web site and
allow you to add additional “news” items.

Prefs When you click on this option Manila will display a list of the site preferences that include
the means for altering the appearance, architecture and access to your site.

Admin When you click on this option Manila displays a list of all of your stories, pictures and
discussion group items. You can delete these items and change membership options if you
are allowing others to edit your site.

Bulletins If you are working on a Manila site as part of a group there may be times when you want to
quickly send others in the group an email message about things you are doing to the site.
Manila allows you to send such messages to other group members without having to use an
external email application. Clicking on this option displays a window where you create and
send such a message.

Logoff When you are done editing your site you should always logoff. This is very important when
sharing a computer because if you don’t logoff the next person that accesses your site from
that shared computer will have full editing access. Clicking this option displays a screen
where Manila asks you if you are sure you want to logoff. Click the “Sign Out” button to log
out of your site.

Help Clicking on this option will take you to a frequently asked questions web page hosted by
Userland, the developers of Frontier and the Manila environment.

Editing the text on your web site

One you have logged in you will be taken to your home page. The main thing to notice is that there is now an
“Edit this Page” button at the bottom of the page. When you click on this button you will be taken to a page
with a web form where you can easily edit the text by either typing in new text (freehand entry) or pasting html
that you have copied from another application such as Appleworks or Microsoft Word.

When you are done making changes click the “Post Changes” button to save your changes. You will be
returned to your home page where you can view the changes. If you don’t like what you see or want to make
slight modifications just click the “Edit this Page” button as before.

Freehand text entry requires just a little html (hypertext markup language)
Many people think that creating web pages from scratch requires knowledge that is very difficult to obtain.
Actually the “language” of the web is known as html which is an acronym for hypertext markup language and it
is not a difficult language. While we don’t want to bother you with a lot of html a couple of things are good to
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know so that you can better format your text. You will use html when you directly edit text after clicking the
“Edit this Page” button.

Bold <b> </b>
If you want text to appear bold, such as a headline, you need to place a <b> before the text you want to be bold
and a </b> directly following the text you want to be bold. For example, if you wanted to bold the title
“Conference times” you would enter the text so that it appeared like this:

<b>Conference times</b>

Setting a line break <br>
When you enter text or paste it into the “Edit this Page” window you create paragraph breaks (a blank line
between one line of text and the next) just as you normally would by making sure there is a blank line between
lines of text. But in those instances when you want to start a new line without leaving blank space you need to
create what is known as a “line break.”  You do this by adding an html tag at the end of the line where you
want the line break. A good example of when you might use the line break tag <br> is when you want to start
text directly below a heading. If you want to bold the headline and then start a new line the text in your “Edit
this Page” window would look like this:

<b>Conference times</b><br>

Creating HTML formatted text with a word processor

There is no question that creating html formatted text is not as intuitive as simply entering text in a word
processor where what you see is what you get. The good news is that we can use a word processor to format,
spell check and save text in html format. It is then a simple matter of entering edit mode on a Manila page and
pasting the html into the “Text” window.  Both Appleworks and Microsoft Word can save formatted text in
html format and both allow you to copy the html for pasting into Manila.

Creating html with Appleworks (Macintosh):
1. Start Appleworks by double-clicking on the Appleworks icon.

2. Enter your text just as you normally would using such formatting options as bold, italic and colors.

3. Save your file in html format by choosing “Save As” from the File menu, selecting html from the drop
down menu, and naming the file with the .html extension (e.g. myfile.html).

4. Open the html file you just saved. You will see that Appleworks has added all the necessary html tags to
make your formatted text render properly on the web.

5. Select all the text and tags that lie between the <body> tag at the top and the </body> tag at the bottom.
Do not include the <body> or </body> tags. Select “Copy” from the Edit menu.

6. Back in Manila click the “Edit this Page” button. Place your cursor in the “Text” window and paste the
html created in Appleworks.

7. Click the “Post Changes”button.

Add a graphic from the library of images

Sometimes you want to jazz up your web page with a graphic or picture. There are two ways to accomplish this,
but the easiest way is to add a stock picture from the library of images we have set up for you. The reason this is
easier is because we have already prepared the graphics so that they will render properly on the web. Adding a
graphic from the library requires simple copy and paste skills.

1. In your web browser enter the address <http://teachers.lps.org/support/> and click on the elementary
graphics link.

2. Find the graphic you want.
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3. If you want the graphic to be justified to the left of your text with the text flowing around it then place
your cursor in the box next to the desired graphic and below the text “Left side of page.”   Drag over the
text in that window to highlight it and then use the Copy command to copy the text. Similarly, if you
want the text right justified and flowing or centered use the same copy procedure in the appropriately
labeled box.

4. Return to the page where you want to place the graphic and click on the “Edit this Page” button. Place
your cursor just before or after the text where you want the graphic to be placed.

5. Select Paste from the File menu.

Adding your own images

No graphics library contains just the right image for every situation and there may be times you want to include
a scanned picture or image from a digital camera. In those cases you will start with the graphic or picture on
your hard drive and upload it to the web server. The three steps in this process include preparing the graphic or
picture to render properly on the Web and then loading it to the server so that you can use it.

Step 1 – Preparing your image file for the Web:
1. You will need to save your file in either jpeg or gif format. Many digital cameras save in the jpeg format

automatically, however, many of the graphic files from clipart libraries are in a format such as pict
(Macintosh) or bmp (Windows). While a complete description of when to save as a gif and when to save as
a jpeg is beyond the scope of these instructions the simple rule of thumb is that you save files with a lot of
solid colors (clip art images) in the gif format and you save photos as jpeg images.

2. In addition to saving your files in the correct format you also need to make sure you have scaled them to a
size that fits the layout of your page. Large graphics take a great deal of time to load in the browser so you
should endeavor to scale your image to the minimum size that still allows you to view the appropriate
amount of detail.

3. It is very important that you save your files with the appropriate three-letter extensions. Manila recognizes
.gif and .jpg so you should use these when saving images in each of the respective formats.

4. There are free programs available that allow you to easily prepare images for the Web. For example:

Macintosh – Clip2GIF <http://homepage.mac.com/piguet/gif.html>
Windows – IrfanView  <http://www.irfanview.com>

Each of these applications comes with documentation clearly outlining how to use the software.

Step 2—Moving your image files to the server:
1. Make sure you are logged into your Manila site.

Click on the “Pictures” link.

2. On the Pictures page click the “Create a New
Picture” link.
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3. On the “Create a New Picture” page enter a short, one-word title for your image (e.g. photo1).

4. Click the “Browse” button and locate the image on your hard drive that you want to upload. Select the
image and click the “Open” button.

5. Back in the “Create a New Picture” page click the “Post New Picture” button at the bottom of the page.

6. You will be returned to the “Pictures” page where the name of the picture you just uploaded will be listed.

Step 3—Placing an uploaded image on one of your web pages (shortcut method)
1. Navigate to the page where you want to place the image.

2. Click the “Edit this Page” button.

3. Find the point amidst the text and/or links where you want the image to appear and enter the name you
assigned to the image inside quotations (e.g. “photo1”).

4. Click the “Post Changes” button.

5. You should be returned to the web page complete with your image.

Optional—Positioning an uploaded image on one of your web pages (html method)
1. Make sure you know the name of the file as it appears on your hard drive. You will need to use that name,

not the shortcut name you assigned when you uploaded the image.

2. Navigate to the page where you want to place the image and click the “Edit this Page” button.

3. Find the point amidst the text and/or links where you want the image to appear. Enter the appropriate
html including the URL of the image file. For this workshop the url of your image file takes the form:
http://osx.lps.org/manila/username/filename. The html tag you must add takes the form:

<img src=”http://osx.lps.org/manila/username/filename” align="left"
border="0”>

The align portion of the tag can be “left,” “right,” or “center” depending on how you want the text to flow
around the image.

4. Click the “Post Changes” button.

5. You should be returned to the web page complete with your image.

Deleting an uploaded image

To quickly remove an uploaded image:
1. Make sure you are logged in to make changes.

2. Click on the Admin link.

3. Beneath the “Stories and Pictures” heading, locate the name of the picture you want to remove.

4. Place the cursor in the checkbox next to the name of the file to be deleted and click the mouse.

5. Click on the “Delete” button beneath your list of pictures.

Adding gems to your web pages

There are many types of rich media that you might want to add to your pages. For example, Acrobat
documents, Quicktime movies, Flash files and Hyperstudio stacks to name a few. You can upload gems to the
server as easily as uploading pictures. Placing links to download gems is a simple matter of uploading and using
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shortcuts,  however,  embedding gems requires some knowledge of html coding. Included here is an example of
how to link to an Acrobat document and embed a Quicktime movie.

Acrobat documents:
1. Make sure the file name of the Acrobat document you wish to upload is one word and includes the .pdf

suffix.

2. Click on the “Gems” link and then the “Create a New Gem” link.

3. Enter a simple shortcut name for the file.

4. Click the “Browse” button and navigate to the Acrobat file. Double-click on it. Important: The name of
the Acrobat file you are uploading must end with the “.pdf” extension.

5. Click the “Post New Gem” button. Depending on the speed of your network connection and the size of
your file it may take some time to upload the file.

6. Once the file is uploaded you will be returned to the Gems pags and the file will be listed along with a
URL to the file.

7. Navigate to the page where you want to place the link to the Acrobat document.

8. Click the “Edit this Page” button.

9. Find the point amidst the text and/or links where you want the image to appear and enter the shortcut
name you assigned to the document inside quotations (e.g. “documentation”).

10. Click the “Post Changes” button.

11. You should be returned to the web page complete with the link to the Acrobat document.

Other File Types
You can follow these same directions to place download links to other types of files you upload as gems (e.g.
Quicktime movies, Microsoft Word documents, Appleworks documents, etc.).  The key difference is that in
Step #4 the file you are uploading MUST utilize the proper file extension for that type of file.  These extensions
are related to specific MIME types understood by the web server and web browsers.  Some of the more
common MIME extensions include:

Appleworks/Clarisworks – .cwk
Hyperstudio – .stk
Flash – .swf
Microsoft Word – .doc
Microsoft Excel – .xls
Microsoft Powerpoint – .ppt
Quicktime – .mov
Microworlds – .mwz

Considerations when using Gems
1. Consider your audience and the typical speed of their link. Large files can take a great deal of time to

download especially via modem connections.

2. Check with your system administrator to make sure that he/she has configured the mime types on the web
server to serve the type of gem you want to include.

3. If the type of gem you want to upload requires a special browser plug-in consider how many of your site
visitors will have the plug-in.
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Adding pages to your web site

After adding content to your front page and “about” page you will likely think of additional pages you would
like to set up. Before proceeding too far you should chart the architecture of your site. That is, try to make a list
of all the major topic pages you will want to link to in your “My Web Pages” site navigation. Then make a list
of all the pages you will link to from each of those. The key is to develop an organizational hierarchy that allows
users to quickly navigate to the major areas of your web site and then to specific areas related to each.

Manila makes it very easy to create additional pages and link to them from your existing pages. What we call
“pages” Manila calls “stories.”

Adding a page (story):
1. Make sure you are logged into your Manila site.

2. Click on the “Stories” link.

3. On the Stories page click on the “Create a New Story” link. The “Create a New Story” page should look
familar as it has the same form you have seen when you edited the front page of your site.

4. Enter a short, simple title in the appropriate box. This is the title that will be displayed above the text and
pictures you place on the page. The title is also the shortcut name you will use to create links to this page
from other pages on your site. Note that when you create a page Manila automatically creates a shortcut to
that page where the title you enter is the shortcut name.

5. Enter the text (html) in the “Text” area. You can either enter the text/html directly into the “Text” area or
you can copy and paste html that you have saved in Appleworks or Microsoft Word. Additionally, of
course, you can place pictures or gems by entering the shortcut title of the picture and enclosing it in
quotations.

6. Click the “Post Changes” button to create the page.

7. You will see the page you just created. You can edit it by clicking the “Edit this Page” button.

Linking to your new page from another page
When you have created a new page customarily you will want to put a link to it on one or more of your pages
so that others can easily get to it. You create a link to stories in the same way that you place pictures on a page.

1. Make sure you are logged in to Manila.

2. Go to the page where you want to add the link to a story.

3. Click the “Edit this Page” button

4. Place the cursor in the “Text” box where you want the link to be displayed.

5. Place the title of the story (shortcut) inside quotations.

6. Click the “Post Changes” button.

Deleting a page (story)
To quickly remove a story:

1. Make sure you are logged in to Manila.

2. Click on the Admin link.

3. Beneath the “Stories and Pictures” heading locate the name of the story you want to remove.

4. Place the cursor in the checkbox next to the name of the story to be deleted and click the mouse.
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5. Click on the “Delete” button beneath your list of stories.

Adding links to your navigation bar

Once you have decided on the information architecture of your site and created each of the pages that will serve
as the major sections you will need to add these links to the site navigation. A good goal is to organize your site
so that you have no more than 10 links in the “My Pages” navigation section. Remember, the goal is to set up
your site in a topical fashion such that the pages linked in the “My Pages” area are the major topic areas with
appropriate contextual links on each of these pages.

For example, you may develop a page for each of the classes you teach and link each of those in the “My Pages”
area. On each of your “class” pages you may link to several additional pages you create that are specific to that
class. This type of hierarchical navigation helps to focus people as they get into your site, while also allowing
them to quickly navigate to the major areas from any page.

Adding a link to the “My Pages” navigation area:
1. Make sure you are logged into Manila.

2. In the list of “Editors Only” links click on the Prefs link.

3. In the list of Prefs links in the left column click on the Advanced link.

4. In the Advanced prefs window locate the text window under the Navigation heading.

5. Using your cursor carefully select one of the “item name containers”:

<item name="About" pagename="/username/about"/>

6. Select Copy from the Edit menu.

7. Place your cursor at the end of the last “item name container” and press the Return/Enter key.

8. Place your cursor in the open line between the last “item name container” and the closing navigator
indicator (</navigator>) and select Paste from the Edit menu.

9. Modify the item name container by changing the “item name” value inside quotations to what you want
people to see as the link to the page you are adding.

10. Modify the item name container by changing the pagename value inside quotations. After having changed
the duplicate:

<item name="About" pagename="/username/about"/>

to something like:

<item name="Links for My Students" pagename="/username/about"/>

change the second part to:

<item name="Links for My Students" shortcut=”Links for My Students"/>

The text in the quotes after “shortcut=” should be the shortcut name for the page that you want to
reference.

11. Click the Submit button just beneath the Navigation text window.

12. Navigate to any of the pages on your site and check to see that the new link shows up in the “My Pages”
section and that clicking it takes you to the desired page.
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What are shortcuts?

As we have seen Manila provides an easy way for you to incorporate objects on your web pages such as pictures
and links to other pages you’ve created. The method for adding a link to a story or placing a picture is a simple
matter of entering the title of the page, or name of the picture, inside quotations when you are editing a page.
This method of including objects on your web pages is what Manila calls using “shortcuts.”  A Manila
“shortcut” is a named reference to an object like another web page, picture or other type of media like a
quicktime movie.

Manila keeps track of all your shortcuts on the “Shortcuts” page. For each shortcut Manila lists the title, or
name, you will have to reference inside quotations as well as the type of shortcut. The three types of shortcuts
are:

• Page: a clickable link to another page on your site or an external web site

• Picture: a gif or jpeg image file

• Gem: other types of media like quicktime
movies, Hyperstudio stacks, or Acrobat files

Adding links to your pages

There are two methods for adding links to your pages. The first method is to set up “page” shortcuts. It’s worth
noting, again, that anytime you create a new story (page) for your site a shortcut is automatically set up. If you
want to set up links to external sites such as nasa, for example, you can set up a page shortcut.

1. Make sure you are logged in to Manila.

2. Click on the “Shortcuts” link.

3. Place your cursor in the name box and remove any text that is there.

4. Enter a simple name/title for the shortcut

5. Place your cursor in the url box and remove any text that is there.

6. Enter the url of the external site (e.g. http://www.nasa.gov)

7. Click the “Add New Shortcut” button.

8. You can add the link to any page by entering the name of the shortcut inside quotations.

The second method for adding links is a simple matter of copying and pasting the urls from your web browser.
Properly formatted urls will automatically show up as links.

1. Open two windows in your web browser.

2. In window 1 login to Manila, go to the page where you want to add external links and enter edit mode.
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3. In window 2 navigate to the site you want to add as a link.

4. Place your cursor in the address bar of window 2, select all the text and select “Copy” from the Edit menu.

5. In window 1 place the cursor in the text window where you want the link to appear.

6. Select paste from the Edit menu.

7. Repeat this process until you have entered all the links you want to add to that page.

Changing your site name

Each Manila web site is initially set up so that the site name is the person’s name that is developing the site. The
site name is what shows up in the banner at the top of each page.

To change the site name:
1. Make sure you are logged into Manila.

2. Click on the “Prefs” link.

3. In the sidebar set of links click on the “Appearance” link.

4. Enter your new site name in the “Site name” box.

5. Click the submit button at the bottom of the page.

You built it, is anyone coming?

After you have your site set up it is appropriate to ask the question, “How many times are my pages being
accessed?  While a complete statistical analysis is not possible with Manila, it is possible to get a count of how
many times each of your pages has been accessed. Such an analysis can be very helpful because it can point out a
problem with your site navigation. For example, if you have a very important page that is not being accessed it
could be that the navigation to that page is not readily apparent to your visitors.

Listing your pages and number of times they have been accessed:
1. In your web browser enter the url - http://teachers.lps.org/yourlogin/stats/mostReadMessages

Adding a “stats” link to one of your web pages:
1. Make sure you are logged into Manila.

2. Enter the URL to view your statistics.

3. Click on the “Shortcuts” link.

4. Change the “Name” field to something simple like “statistics.” And click the “Add New Shortcut” button.

5. Navigate to any page on your site where you want to add a statistics link.

6. Click the “Edit this Page” button and insert the shortcut (e.g. “statistics”).


